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Paperspace/ Layouts

This is the Modelspace plane.
You draw your model here.

The final product is a titleblock
with a viewport looking back into
Modelspace. The viewpart can be
set to any zoom scale factor.

This is the Paperspace plane.

You place your titleblock here,
add plan naotes, ete.

Think of it as a picture frame with
a clear glass window that you look
through to see your model.
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Paperspace
The Modelspace tab, pick Faperspace Layout tabs, pick
here to turn off the display any one of these tabs to display
of Paperspace and return to that Layout.
Modelspace.
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Paperspace

- When drawing by hand you use an architeg.
fural scale to draw a reduced drawing at a
measurable slze (like 178" = 1°.07).

+ When drawing In AuteCAD you draw at real
world size (full scale) and AutoCAD will
reduce it to the appropriate scale.

Paper Space versus Model Space
AULOCAD hias two different areas that you will
use to ereate scaled drawings.

Model Space

- MODEL SPACE (or the Model tah] is the place
in AutaCAD where we draft 95 percent of our
lines,

- While in Model Space, you draft at trye world
scale. True world scale means ifyou are
drafting a room thatis 30'-8" wide by 200"
deep in Model Space you will deaft your lines
306" wide by 20°-0° deep.

Paper Space [ Layout View

- The LAYOUT VIEW (Layoutl, Layout2, and
Layout3 tabs) is the place in AutoCAD where
Yo 5et up the sheats you are going to print
arplot,

- Anything that you draft in your Layout View
will print the same size as you drafted it,
Therefore, ifyou add 1/8" tall text ta your
Layout view, this text will measure 1/8" tall
an your prnted sheet,

j T Viewpart

« The gpening (or window) you see in the
Layout Wiew is called a VIEWPORT. Viewports
allow you to see through your Layout View to
the project you drafted in Model Space.

scale factor: 48
seale ify" = 1'-0”

scale facton: o6

acale /8" =1

AutoCAD Scale Factors
The Scale Factor concept Is unique to AutoCAD.
In this diagram, the Scale Factor represents the
distance between Model Space and the Layout
View, Ifyou move Model Space farther back,
then the drawing In your Layout View will get
smaller. If you move Mode! Space closer, then
the drawing in your Layout View will get larger.
« Fora drawlng/viewport to be scaled

1/a% =1"0" the scale factor is 48,
« Fora drawing/viewport to be scaled

1/8% = 1"-0", the scale factor is 96,

+ Asyou increase the scale factor, you are
increasing the distance between Model
Space and Layaut View which decreases the
primed size of your drawing.

The fallowing is a list of drawing scales and
thelr AutoCAD scale factors:

Drawing Scale Scale Faclor |
e Ta

I
=1 12
18
24
a2
48 |
&4

o

128

182
384
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Paperspace

To change the paper size, go to the Page Setup Manager.
Found by Right Clicking on the Layout Tab.

-In the Page Setup Manager, we are going to Modify the Page.

-In Page Setup, change the Printer to a large scale plotter (or

Adobe PDF)

Change the Paper Size to ARCH D (24" x 36").
Plot Area should be Layouit.
Set Plot Style table--- to Monochrome (for now)

W Page Setup - Layoutl

Page setup
I Mame: <MNone>
Printer fplotter
Mame:
Plotter: MNone
Where: Mot applicable

Paper size

configuration name is selected.

7 I

w

Description:  The layout will not be plotted unless a new plotter / g
7

[ [ARCHD (24.00 x 36.00 Inches)

—

Plot area
What to plot:

x:  0.000000  inch

y:  0.000000  inch

Preview...

Basic AutoCAD Interface

Plot offset (origin set to printable area)

Center the plot

Plot scale

Fit to paper

New layout i

From template...

Delete

". iR ol - ::
Rename AR L
Move or Copy... ol ;
Select All Layouts T j ‘ ;

Activate Previous Layout

: Page Setup Manager... > !

Plot...

A\

Drafting Standard Setup...

= Import Layout as Sheet..,

Export Layout to Model...

Hide Layout and Model tabs

; e

EIKICEC

T e A A B e e

[ Display plot styles

Shaded viewport options

Shade plat As displayed

DRI

Flot options
Flot object ineweights

[ Plot transparency
Plot with plot styles
Flot paperspace last

Drawing orientation

sl

1

[ Seale lineweights

:
unit

() Portrait

@ Landscape B
[ Plot upside-down
[ OK ] [ Cancel ] [ Help ]

E Page Setup Mai

2

h‘ Current layout: Layoutl
DWG

Page setups
Current page setup: <None>

Hayout1*

Hayout2 (2)*
ALayoutd™®

Set Current

Display:
settings

Selected page setup details

Device name: MNone

Plotter: Mone

Plot size: 24,00 x 35.00 inches (Landscape)

Where: Mot applicable

Description: The layout will not be plotted unless a new plotter

configuration name is selected.
["| pisplay when creating a new layout [ Close J [ Help ]
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Attach the Titleblock (and other External References) B @ Ba= |
= i POt Cioud ~ |import|  Data | Linkir
1. Insert Tab--- Reference Panel--- Attach Drawing |
2. Find the Titleblock file and click Open. . — - :
= e 1= = =
3. “Attach External Reference” window: { L :,D : i
Make sure that Scale is set to 1.0, 1.0, 1.0 | i A |
Insertion Point should be 0,0,0. \eiz / L
B  ————— =8 ) |
; £ |
4. The titleblock should then fit perfectly onto the page. — d

M

Name: | SEMESTER TITLEBLOCK -] [ Bromse.. |
Preview Scale Path type
[ Specify On-screen
Full path -
X o0 [Fullp
Yo 100
Ratation
Z
1.00 [ Specify On-screen
Uniform Scale
O Angle: g
Insertion paoint
[ Specify On-screen
Block Unit
X 000
i==cehne Unit: Inches
: ' Yo 000
@ Attachment () Overlay
Z om Factor:  1.0000
Locate using Geographic Data
Show Details [ ok || Cancel | [ Hep
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Re-attaching an External Reference

If your titleblock or image (that has been referenced

=

from another file) is missing, then follow this
process...

Go to the Insert Tab--- Reference Panel

Click on the little arrow in the lower right corner
(or type in XREF (or EXTERNAL
REFERENCE)

This opens up the External References panel
with a list of all attached files (images and
dwgs). You can reload the attached files here,
you can also attach files using this panel by
clicking the attach button in the upper left
corner,

If a file has lost its connection, you can re-
locate the path by clicking on the file and under
Found/ Saved Path, you can re-link the file.

=g ASSIGH

Annotate

(=) Salos (o = €51 Drafting & Annotation -

Layout  Parametric  View Onli

L__E:\] \% ) ES/ Eﬂd@ [ Underlay Layers

#F, e
Edit Creaste  Define Manage Block | Attach Clip Adjust [l *Frames vary
Attribute ™ Block ~ Attributes Attributes Editor

Block v | Block Definition = |

Manage Output  Plug-ins

Insert
.!:‘5 Snap to Underlays OM ~

Reference =

xX
| B2~ =
= -| .
Referen/ce Status Size = File References BIE
[N ASSIGNMENT... Opened 154 Kt e — Size
200 scale map... Leaded 216 M :_-.! ASSIGNMENT... Opened 154 Ki
2000 scale ma... Loaded 290N S—— I S————
20000 scale m... Loaded 148N 2000 scale ma... Loaded  2.90 M
FALL PILOT A.. Loaded 646 Kt e s iead 1ag]
B2 SEMESTER TI.. Loaded 791K B FALLe Np—
SEMESTER TL... Loaded 53.0K
i oace [ E SEMESTER TL.. Loaded 791K Tb
[e] vAG structur.. Loaded 513Kt — -
] YAG_structur... Loaded 513 KE
Y A
= il @ LI T | 3
= Attach DWG... 5
Attach Image... L |'|'De},puse — [El=] |:,.'|
Attach DWF... :
B g | Date 9/7/2012 1:15:29 PM
Attach DGM... 16 M o e =3
o aund At L. bdy=blacugents
Attach PDF... 180 1 o
Sl 5-ved Path ([ TITLEBLOCK.dwo| i
Attach Point Cloud... 48 b = =
ErRrrrreTEsrorauer—udd Kt c ] — 1M | b
o
B3 SEMESTER TL.. Loaded 791K #
% SEMESTER L. Loaded 530K &
[&] vAG_structur.. Loaded 513 KI *
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Add a Viewport

AutoCAD usually starts up with a viewport in
each layout tab. If it doesn’t, then follow
these steps...

1. Go to the Ribbon--- Layout Tab--- Layout
Viewports panel--- Rectangular Viewport

2. Draw a Rectangle viewport on the page.

3. Select the Viewport border and adjust the
blue grips to re-size it.

4. To zoom/ pan around the viewport, double
click inside (or click on the Model/ Paper
button on the bottom of the screen to
switch between Paperspace and
Modelspace. Zoom/ Pan around the
screen as needed until the view shows in
the window.

5. Double-click outside the viewport (or click
the Model button at the bottom of the
screen to switch back to Paperspace.

ASSIGMNMENT A.dwg

[l e {é}Draﬂing & Annotation -l

ome Insert  Annotate [MEWGINE Parametric  View  Manage

BE < \EZ Named 0 [:" 5 [“ e
= ; = g
O §a B S 06 02 7 |2 O
Mew  Page \ Rectangular Base Projected Section  Detail Edit Edit Symbol |( Auto | Update

View Components | Sketch ||Update| View

Output  Plug-ins  Online  Express Tools

| Create View | Modify View | Update |
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Change the Viewport Scale

New Page | Rectangular
* Setup #

keyword or phrase {1
a ayoul Parametric View Manage utpl ug-ins Online xpress Tools -

amed | 1y . - ~, [EG7
= == E[‘i. o Cz 5 @A B2 |55 [imperie = L2

Cli
B % | Gue projected Section  Dewmil | Rt Edn Symbol | Auto | Update | @8 imperiai2s
Block~| - - B View Components  Sketch ||Update| View ~

1. Select the Viewport, or click inside the o | tonvonpos | ceseve | weotver e | syemmaswirs
viewport window to select it.

18
110

116
1:20
1:30
1:40
1:50
1:100
21
41

2. Click on the Scale button in the lower
right corner.

‘ &1
10:1
100:1
1/128" =1'-0"
| 1/64"=1'-0"
|
I

3. Change the scale as needed to ensure
accuracy.

1/32"=1-0"
1/16" =1'-0"
332" =1-0"
1/8"=10"

3/16"=1'-0"
14" =10"

Note: If you zoom in the viewport, it will

1/2"=1'0"

change the scale. — e
g 4] 4[» W[} Model } Layout1 ,@wﬂj,,@qﬂém ,_ H

_10"

Note: Remember to check the viewport
scale afterwards before printing to
make sure it’s accurate!
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Change Linetype to Dashed or Center-line

ate & A= ] — R X
. ror (7] Fillet ~ & Uf\zavEdLayErStatE | /© Leader ~ i :2 e & 1]
1. Select the lines that you want to change. e e ) (R o 3| - B | @k "8 " &

dity ~ Layers ~ | | ByBlock

[ — - avie I

Continuou: 5

2. Click on the Home Tab--- Properties Panel. — e
-

—— — ~SEMESTER TITLEBLOCK- SITEMAPS|ACAD_ISO02W100 !=

——--—- SEMESTER TITLEBLOCK- SITEMAPS|PHANTOM2

—— —— - SEMESTER TITLEBLOCK|ACAD_ISO02W100

3. Use the Color button to change the color.

—--—- SEMESTER TITLEBLOCK|PHANT QM2

4. Click Linetype to change the linetype to
dashed or Center-line.

5. If you don’t see the linetype listed, then click
“Other” at the bottom...

6. In the Linetype Manager screen, click “Load”,  [ifseeiverss N = |

then find the Linetype from the list. Linetype fiters == e
| Show all linetypes | [Clinvert fiter
. - . ’ Cument ] ’ Show details I
Cument Linetype: Bylayer
Linetype fiters W
Show all 1" 1 i et
ik Linetype Appearance Description

Curert Ll File... acadlin g?:;::};

Linetype | | Available Linetypes CENTER —_— O o o e ppea o
g:lélavel: Linetyps Description Continuous ———— Continuous

[e]e —_— e — —
cenTer Il [4cAD_iso1sw00 IS0 double-dash triple-det ____...__ __ . DASHED Dashed ______ __ ___ __ ___
Contiruoudll [BATTING Batting SSSSSS5555555555555555855555! FHANTOM2 : —-—-—FPhantom (%) _________ ___ __
DASHED ||| eoRDER Border .. ) ] =l SEME.. EMAPS :'-‘\.C;'—‘\D...Z."d"IDI? — —— —— — 150 dash b cocomnrannisany w s vecoommoannis
PHANTOMY |oRpER2 Bt (50 5 % s B & @ @ @ 3 SEMES.. TEMAPSIPHA. . TOM; — --—--— Phantom (%S¢} ___ ___  ___ ___ __
SEME..H Border (34) SEME..BLOCKIACAD..02W10 — — — - 1SOdash _ __
SEME: S ko e s 2
SEME.. ) Caery  wwr s e e twew o SEMES.. EBLOCKIPHA.. TOMZ —--——--— Phantom (B _
SEMES. B Center (& __ __
| "
[ ok J[ camcsl |[ Hep | [ ok || Caneel || Hep |
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Text Command
-Type MTEXT or use the Text button found on the
Ribbon--- Home Tab--- Annotation Panel--- Multi-line Text

AutoCAD 2013 - STUDENT VERSION  Drawingl.d.. |y

Output

Plug-ins  Online  Express Tools = -

£ % g £ 2 %
Unsaved Layer State
-Specify a rectangle where you want the text to go. || Q vaf 0

-Choose a standard font (Arial).
-The text size has to be scaled. [See Chart on next page]

#
i

Layers «

AutoCAD 2013 - STUDENT VERSION

Drawingl.d...

Home Insert Annotate Layout Parametric View Manage Output  Plug-ins  Online

~ & Annotative I F Arial i= Bullets and Numbering ~ ([? ABC | [ More -
AaBbCcD||AaBbCcD = o= = - - : [
3/16° v Byl M = Line§ - Rul
= O [ByLayer A e s i Spell Edit Find & Close Text Editor

M 1t = = == = Check| Dictionaries | Replace

A Annotative Standard

Style | | Spell Check  »| Tools | Options | Close

[=1ToplI2D Wireframe]

E‘I"' R T e e IIIIILO
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Text Command

Standard Drawing Title
-The text size has to be scaled depending on what scale your final print will be. Drawing Text ~ Text
Drawing Scale | Code | Scale Factor| LT Scale| 3/32” Text ] 1/8” Text
|

17=1" (Full Scale)] | 1 1.0 0.5 332" | 1/8”
132" = 1'-0" 3 384 192 36° 48"
1/18" 6 192 96 18” 247
148" 8 96 48 9" 12"
1/4" 4 48 24 41/2" 6"
12" 2 24 12 2114 K
3/4" E 16 8 11/2° 2
4" D 12 3] 11/8” 1 1/2”
1-1/2” C 8 4 3147 1"
3" ] 4 2 3/8” 172"
6" A 2 1 3/1e” 1/4”
364" = 1’0" M 256 128 24" 327
37327 H 128 64 12" 16°
3/18” G 64 32 6" 8"

110" = 10" N 120 60 11 1/4” 15
1/20" P 240 120 22 /2 30"
1/30" Q 360 180 33 3/4” 45
1/40" R 480 240 45" 60"
1/50" S 600 300 56 1/4” 75"
1/100" T 1200 600 112 1/27 150"
1/200" U 2400 1200 225" 300"
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Dimension Command
-Dimensions are easy to use but they must be set-up first!

Type DIMSTYLE or use the Text button found on the
Ribbon--- Home Tab--- Annotation Panel---(Down arrow at bottom of

panel to expand panel--- Dimension Style button.

-Dimension Style Manager— Click New (or Modify).

-2 main settings to adjust here:
1. Primary Units--- Change Unit Format to Architectural (Ft/ inches)

2. Fit --- Scale for Dimension features--- Use Overall Scale of:
[Use Chart]

AutoCAD 2013 - STUDENT VERSION  Drawingl.d.. e

putput ~ Plug-ins ~ Online

bS8 &5

Unsaved Layer State

G el 0

| Layers «

T Dimension Style Manage

Curmrent dimension style: Standard
Styles:

Express Tools .

F|<h A | Linear - ”_'7 % Create
v Leader ~ % Edit
Text S Insert st
- - Table @ -

Block -

s | Standard

‘§| Dimension Style
| Creates and modifies dimension styles
1 | —
e DIMSTYLE
Press F1 for more help

Preview of : Standard

A& Annotative

List:

Description
Standard

Al styles

Dont list styles in ¥refs

i ©

L
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Dimension Command

-2 main settings to adjust here:
1. Primary Units--- Change Unit Format to Architectural (Ft/ inches)

2. Fit --- Scale for Dimension features--- Use Overall Scale of:
[Use Chart on next page]

Jﬂnaw Units INtemate Units IToIemnce5|

| Lines IS‘,'mbols and Amows ITexlk[ Fit

P ——
| Lines I Symbaols and Amows I Text I Fit (l Primary Units I}ﬂema‘fe Units I Tolemncesl

Fit options

if there isnt enough room to place both text and
amows inside extension lines, the first thing to
maove outside the extension lines is:

i@ Eithertext or amows (best fit)
) Arows
) Text

") Both text and amows
() Mways keep text between e lines

Scale for dimension features
7] Suppress amows i they dont fit inside

extension lines [T Annotative
() Scale dimensions to layou
Text placement ) =
@ Use overall scale of: 10000 =
When text is not in the default posttion, place t:
@) Beside the dimension line Fine turing

() Ower dimension line, with leader

() Over dimension line, without leader

Linear dimensions

Unit format: ([

Architectural

Precision

00 1/16"

Fraction format: [

Harizontal

Decimal separator:
Found off:
Prefoc:
Suffoe:
Measurement scale

Scale factor:

1.0000

[7] Apply to layout dimensions only

Angular dimensions

[T Place test manualy Zero suppression Units format: [DBCiITIEI' Degrees 'l
[7] Draw dim line between ext lines Leading ] Trailing B [ﬂ ]

Sﬁul:ﬁ.lnrts factu:url. Dfest Precision:

i . Zero suppression

; ; 0inches
Sub-unit suffic [ Leading
[ Trailing
[ ok | [ cancsl | [ Hep
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Dimension Command

-The dimension size has to be scaled depending on what scale your final print will be.

Drawing Scale | Code | Scale Factor || LT Scale | 3/32” Text 1/8” Text
17=1" (Full Scale}} | 1 1.0 0.5 3/32° 1/8”
/32" = 1-0" 3 384 192 36" 48"
1/16" 6 192 96 18 24"
1/8” 8 a6 48 9" 12"
/4" 4 48 24 41/2" 6"
112" 2 24 12 2 1/4" 3
3/4" E 16 8 11/2" 2
D 12 6 11/8" 1 1/2
1-1/2" C 8 4 3/4” 17
3" B 4 2 3/8” 1/2°
6" A 2 1 3/16” 1/4”
364" = 1'-0" M 256 128 24" 327
3/32” H 128 64 12" 16
3/16" G 64 32 6" g8"
110" = 10" N 120 60 11 1/4” 15
1/20" P 240 120 22 112" 30"
1/30" Q 360 180 33 3/4” 45
1/40" R 480 240 45" 60"
1/50" S 600 300 56 1/4” 75"
1/100" T 1200 600 112 1/2” 150"
1/200" U 2400 1200 225" 3007
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Dimension Command

-2 more settings that may improve the aesthetics of your dimensions.
1. The text height--- change to 3/32”
2. The arrow size--- change to 3/32”

A Modify Dimension Style: Standard eS| (G Moty Dimension ShieSandad X
P ——

P
| Lines I Symbols and Ar6w5 | Text | F'rt) I Primary Linits I Altemate Units I Tolemnces| Line{ | Symbols and Amows | I Fit I Primary Units I Altemate Units I Tolemnces|
Text appearance

Amowhe
. First:
Text style: | Standard -]l =
Text color: ID ByBlock Second:
Fil color: (3 Nore | BB Closed flled
- Leader:
Text height: e | BB Closed filed
Fraction height scale: 1.0000 Amow size:
[] Draw frame around text gl — Arc length symbol
Text placement Tent alignment Center marks a S L
) None () Above dimensgion text
Vertical: [Centered v] (@ Horizontal é e 0031 = # None
@ Ma = :
Horizontal: [Centered ,] ) Line Radius jog dimension
() Migned with dimension line Soaanie:
View Direction: [Leﬂ-to—nght v] Dimension Break g ang 45
(Offset from dim line: 033z = ) 150 standard Hedd=e: Linear jog dimension

Jog height factor:

1172 = * Text height
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Labels and North Arrows
-Use these dimensions to create your Labels and North Arrows for your
Grid Plan and Floor Plan

TEXT HEIGHT: 1'
YALE ART GALLERY- STRUCTURAL GRID J

]
T e
1 o T 20 30 ., |

TEXT HEIGHT: 1" —/ ‘ | 2
| 14' | 56' | 30 |
6" _)\/ R3-9"
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Labels and North Arrows

-Use these dimensions to create your Labels and North Arrows for your
Site Maps

(If you inserted the images into your drawing at a scale of 1.0.

If not, then use the labels from the last page.)

SITE MAP [2007]

SITE MAP [2,0001

TEXT HEIGHT: §"

SITE MAP [20,0007]

4{ }__‘PRODUCED BY AN AUTODESK EDUCATIONAL PRODUCT

R1"

75 150 300

750 1500 3000

e

13Naoid TYNOILLYINA3 ¥S3A0LNVY NV A8 d32NAa0yd

— T —
7500 15000 30000 T
i 2 i 8" 3" |\ TEXT
HEIGHT: 1/8"
Basic AutoCAD Interface AutoCAD Skills AutoCAD Standards




